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Participants will learn how to use Revit software as a powerful and rapid geometry creation tool. As 
energy analysts and mechanical engineers, we often require multiple energy analysis programs to 
produce energy performance models, compliance models for Title 24 and Leadership in Energy and 
Environmental Design (LEED), load calculation models, and computational fluid dynamics (CFD) 
models. We can save significant time and money by using Revit software to create a single analytical 
model that we can export to various programs, including Simulation CFD software, eQUEST, 
energyPRO software, Trane’s TRACE software, Integrated Environmental Solutions Ltd.’s Virtual 
Environment software, and California's new CBECC-Com software. This class will provide a detailed 
workflow for creating the geometry and exporting to the various programs, and you will discover tips and 

tricks to help troubleshoot and control the quality of your mechanical, electrical, and plumbing designs. 

Learning Objectives 
At the end of this class, you will be able to: 

 Understand how to use the Revit software workflow for rapidly building an analytical model from an 
architectural model 

 Learn how to use Revit software and the Green Building Studio service to export to multiple energy 
analysis programs 

 Learn how to use Revit software to quickly import a full lighting design into an energy model 

 Learn how to use Revit software to create CFD boundary condition geometry 
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Introduction 
Over the past several decades, detailed energy analysis has become an integral part of the 

design process for the built environment. Designers, Engineers, and Owners have come to rely 

on whole-building energy simulations and Computational Fluid Dynamics (CFD) to provide 

valuable feedback on the performance of their proposed designs to ensure the project meets its 

energy and occupant comfort goals. 

As a part of this process, Energy Analysts and Mechanical Engineers often require multiple 

energy analysis programs to produce energy performance models, compliance models for Title 

24 and Leadership in Energy and Environmental Design (LEED), load calculation models, and 

computational fluid dynamics (CFD) models (often requiring different software for each 

instance). The workflow presented here will give an in-depth demonstration of how a single 

analytical Revit model can be used to generate the input geometry for use in multiple analysis 

programs.    

 

Rapid Analytical Model Geometry Creation 
The power of Revit, in terms of energy analysis, lies in its ability to rapidly create an analytical 

representation of a building’s various envelope components (i.e. walls, roofs, windows, and 

skylights). We use the term “analytical model” to differentiate between a detailed architectural 

model and a model that only contains the elements required to produce an accurate energy 

model.  

Typically, the process begins with a detailed Revit model provided to the Analyst by an 

Architect. The Analyst then creates a simpler analytical model which can then be imported into 

various analysis programs via the Green Building XML (gbXML) schema. The following 

subsections provide a detailed workflow of this process. 

Project Template File 

**NOTE** - Much of the information in this section has been previously presented at previous 

Autodesk University classes. Therefore, with permission from the Aryn Bergman, original 

author, I have reproduced it here with minor edits. 

Creating a template file with the most commonly used families and views will help to expedite 

the creation of your analytical model. The idea behind using the template file is to preserve 

useful views, construction types, and schedules that will be used for every project. For example, 

it may be useful to have multiple 3D views in the template file; perhaps one showing the 

analytical model and architectural model together and another with only the analytical model. 

While each user will have a customized version of the template file, there are several items that 

should be included. The following subsections will provide suggestions on which items to 

include and how to set them up.  
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Envelope Families 

Start with creating exterior, interior, and underground walls. Click on the structure “Edit” and use 

only one thickness as walls with varying thicknesses will introduce errors in your model.  Create 

different materials for your interior and exterior walls so that you can assign different colors for 

identification purposes in your model.  If an interior wall is mistakenly used as an exterior wall, 

then that surface will appear in the DOE2 or EnergyPlus model.  Do the same for interior and 

exterior floors and roofs.  Again make sure to use a standard thickness (i.e. 6”) because in 

some models you will need to align roofs to floors. 

For windows and skylights, create families that are only 

openings with an extrusion representing the glazing 

area. They should be modeled with a simple geometry; 

detailed geometry may cause errors in the energy 

model and will slow down CFD model run times. 

Doors are rarely used in energy models as ASHRAE 

90.1 states that you do not need to model an exterior 

surface if it is less than 10% of the overall surface area 

of the building.  If doors are needed, then follow the 

same guidelines for creating windows and skylights.  

Use simple geometry and a different material surface 

for identification purposes. 

For building shading devices create a family type for the 

walls for vertical shading devices and a family type of 

roof for horizontal and angled shading devices.  

Thickness does not matter. 
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Views 

Adding customized views to the project template will speed up the initial project setup as well as 

the creation of the analytical model. To begin, create an elevation view on the default floor plan 

that is present in the new project. Make sure the discipline is set to Architectural. Enter the 

elevation view and create a set of placeholder levels. Create a reasonable number of levels 

based on the type of projects you work on. My template file has 5 floor levels and a roof level. 

The floor-to-floor height doesn’t matter at this point, as you will align the levels to the 

architectural model when you start the project.  

Then, create floor plans that correspond to the levels you’ve created to serve as place holders.   

 

 

Next, create the remaining three elevations, one for each of the primary orientations. You can 

add additional elevations if required for specific projects. 

It is useful to create floor plans and 3D views with the Discipline set to “Architectural” so that the 

architectural elements are more visible and easier to select.  Create a sub-Discipline “Energy 

Modeling” for larger projects where you’d like to group views with the energy analysis geometry 

together in the project tree.  



One Model to Rule them All: Using Revit to Create Multiple Analytical Energy Models 

6 
 

 

Create a view on the ground floor with the Orientation set to “True North.”  This will allow you to 

create the geometry in plan view, but be able to rotate the project True North anytime without 

affecting the orientation of other views. Keep the orientation set at “Project North” for all other 

views.  

Space and HVAC Zones schedules are another feature to include in your template file that will 

save significant time. They can be used to display relevant information about the spaces you will 

be creating in spreadsheet form, such as Space Name, Zone Name, Level, Area, Space Height, 

and load information. In most cases, it is much easier to edit these quantities in spreadsheet 

form. On the Project Browser tree, right-click “Schedules /Quantities” and create a space 

schedule. 
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You can then add any of the information in the “Available Fields” section to be displayed in your 

schedule.  

 

Creating the Analytical Model for Energy Modeling 

In this section, creation of the analytical model will be discussed step by step. The general 

approach to this workflow is to “trace” over the architectural model, recreating a simplified 

geometry. Keep in mind that the workflow presented in this section is specifically for importing 

into energy modeling software like eQUEST and IES-VE. We will discuss modifications to this 

approach for CFD in another section.  

Before jumping into the workflow, let’s discuss some general rules to follow throughout the 

process.  

General Modeling Rules  

1. Simplify geometry whenever possible – The analytical model doesn’t need to reflect 

every detail of the building; it just needs to capture the features that significantly impact 

the energy consumption of the building.  

a. Exterior envelope components (windows, walls, roofs and floors) should be 

modeled as close as possible to the architectural  

b. Interior Zoning can be simplified.  

i. Group spaces with the same occupancy type and thermal exposure 

together into a single zone 

ii. Try to create rectangular shaped spaces whenever possible. There is no 

need to capture each nook and cranny of interior spaces 

iii. Don’t include shaft or stairwell openings in floors and ceilings 

iv. Don’t allow gaps between architectural elements 

v. Don’t include columns, shafts and other building components that don’t 

bound occupiable spaces. 
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c. Don’t include doors unless they represent more than 10% of the exterior surface 

area of the building  

2. Do not use design options. Save separate instances of the model to accomplish this 

3. Do not use in-place families. Use the native tools for windows, walls, floors, roof, etc. In-

place families do not translate to the energy analysis program 

4. Under the Area and Volume computations (Analyze>>Space & Zones>>Area and 

Volume Computation) set the Volume computations to Areas and Volumes.  

Step 1 –Link Architectural Model  

Begin by opening Revit and creating a new project. Start with the template file discussed in the 

previous section.  

 

Navigate to the Level 1 floor plan, then navigate to the Insert tab on the ribbon and click “Link 

Revit”. Navigate to a saved copy of the architectural Revit model you wish to use. Make sure to 

change the positioning to origin-to-origin 

 

Make sure the “Room Bounding” building constraints for the linked models is NOT checked. 
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Step 2 –Set Orientation and  

In the floor plan oriented to true North, click on Project Location under the Manage tab and 

either rotate True North or Project North to the correct orientation. 

 

 
 

Step 3 –Align Levels  

It is important to align the floor-to-floor heights of your template file with the architectural model 

so that you get an accurate accounting of exterior wall area.  

Navigate to any of the elevation views. You will notice “Level” annotations belonging to both 

your template file and the architectural model. Use the “Align” tool to move the template file’s 

level to the same height as the linked file. 
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Now, when you open a floor plan in your model, you will see a floor plan from the linked model. 
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Step 4 – Draw Exterior Walls  

Starting with the lowest level, begin by creating exterior walls by tracing over the linked model. 

Set the base constraint to the level you are working on and set the top constraint to the level 

above. It is often easiest and most accurate to set the “Location Line” to Finish Face: Interior. 

This makes the floor area bounded by the walls accurate.  

Notice in the image below that the analytical wall is thinner than the architectural wall. This is 

irrelevant to the energy analysis. The only important aspect is an accurate floor and wall area.  

Also note, by setting the linked model as halftone in visibility graphics makes it much easier to 

distinguish between analytical and architectural elements.  

      

Continue tracing all the exterior walls to establish the shape of the building. Revit has several 

tools in the Modify tab of the ribbon that allow the geometry to be drawn much quicker than 

most energy modeling programs, such as trim/extend, align, array, copy, and paste.  

One particularly useful item is the “Paste- Aligned to Selected Levels” tool. This comes in handy 

if you have a building with a uniform shape on multiple levels. You can simply draw the first floor 

and then copy up to the typical floors.  

Items to Note: 

1. You can use the same wall type for both above ground and below ground surfaces. The 

GBXML export process will differentiate between the two. 
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2. Don’t make walls that traverse multiple levels. This will cause problems during export. 

Use the Copy and Paste tools to copy up walls that are identical on multiple floors. 

3. Model spandrel glazing as an exterior wall 

4. Only use one type of exterior wall. You must assign different wall types in your energy 

modeling program once it’s been imported.  

5. Model curved walls by breaking it up into several straight sections  

Step 5 – Draw Windows 

Draw windows in elevation view by placing a window at the same location shown in the linked 

model. Use a simple window geometry that doesn’t have a complex frame. Simply place a 

default sized window over the window in the architectural model and use the align tool to match 

the dimensions.  

 

Windows can also be copied and pasted in floor plan view if the size and sill height are the 

same. If multiple floors have typical window arrangements, then you can use the copy and paste 

to selected levels tool in the same manner as with the walls. Simply lay out one of the floors and 

copy the typical windows up to other levels.  
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Offset the edge of the window from the edge of a bounding wall, floor, or roof by at least 0.5”, 

even for curtain walls.   

 

And here is an image of a window with the offset: 

 

Items to Note: 

1. If you have multiple windows at a fixed distance apart, you can you use the Array tool  

2. Model curtain walls as a single pane of glazing (i.e. don’t model the individual sections 

separated by mullions) 

Progress so far… 

At this point, you have the shell of the building and windows placed.  
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Step 6 – Draw Floors and Roofs 

Draw floors using the “Pick Walls” tool: . Simply select all the exterior walls which define the 

boundary and a floor will automatically be drawn. As with other envelope elements, it can easily 

be copied up to other typical floors.  Remember to use only one type of floor throughout the 

project. Model slab on grade as an exterior floor as well.  

Roofs are drawn the same way. Use the same thickness for roofs as you used for floors.  

Items to Note: 

1. Use only one floor type throughout the project. It has been my experience that only 

exterior floor types (as opposed to interior) will export correctly through GbXML. Use 

exterior floors on all levels of the model.  

2. After completing the floor, you will be prompted “Would you like walls that go up to this 

floor’s level to attach to its bottom?” Answer NO to this prompt. It can sometimes 

introduce errors otherwise.   

3. Any floor that extends beyond an exterior wall should be modeled in two separate 

pieces; the section with an interior space above as a floor and the section with exterior 

above should be modeled as a roof; otherwise you will receive an error in your model. 

4. Do not model stairwell or shaft openings in floors  
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Progress so far… 

You now have a complete shell.  

 

Step 7 – Interior Walls and Space Separators 

Now that the exterior shell is created, the interior needs to be zoned according to thermal 

exposure and occupancy type. The same wall type used for the exterior can be used for the 

interior. The GbXML export process will differentiate between internal and external walls 

automatically.  

Use space separators for zoning out spaces were walls don’t exist (in open office spaces, for 

example). In eQUEST, this will result in walls composed of air. In IES-VE, this will result in walls 

with full-sized holes in them.  
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Items to Note: 

1. Interior walls should always be full height (i.e. from level to level) 

2. Space separators do not have a height associated with them, but will automatically go 

from level to level.   

Step 8 – Create Spaces and Zones within Analytical Model 

Now that you have all the necessary bounding elements in place, it’s time to create spaces in 

the analytical model. Spaces are objects in Revit that hold all the relevant load data, such as 

exterior envelope components and lighting loads, that are exported to the energy modeling 

software. HVAC zones, or just simply zones, are intended to be a collection of spaces. For 

example, you might have 3 office spaces in a single HVAC zone. However, for the purposes of 

energy analysis, it is easiest and most straightforward to create one zone per space. Adding 

multiple spaces in a zone creates a level of complexity that is generally not necessary for 

energy analysis. Also, eQUEST does not allow you to have multiple spaces in a zone; the 

software is intended to work with one space per zone. Both elements are required for a 

successful GbXML export.  

Click the “Space” button under the Analyze ribbon tab. Then, ensure that the space’s height is 

floor-to-floor by setting the “Upper Limit” constraint to the level above. This is a critical step, 

because if the space does not encompass the bounding surface above (either the floor or roof), 

that surface will not export through GbXML. Use a section to inspect the vertical shape of the 

space to ensure it is properly aligned. Notice in the picture below that the space goes from top 

of slab to top of slab.  

 

Another critical step is to use a limit offset for spaces which reside under a roof element. The 

offset should be at least the thickness of the roof construction element.   
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Next, use the “Place Spaces Automatically” tool that becomes available. This will create a space 

element in every fully bounded area. If you forget to set the space limit before placing the 

spaces, you can simply window select all and use the filter tool to select only the spaces. Once 

all spaces are selected, you can change the upper limit and offset globally for all spaces in the 

current view.  

Next, create a HVAC Zone for every space by first selecting the space, then clicking the “Zone” 

button under the Analyze ribbon tab.  

Note, in most instances, architects will use rooms in thier model. It is important to understand 

why we can’t use rooms for the purposes of energy analysis. The space element holds all the 

loads data associated with the space and rooms do not. So if you want to export LPDs and 

EPDs or any other of the load features, you must use space elements.  

Items to Note: 

1. Create one Space and HVAC Zone element for each zone desired in the energy model 

2. Make sure space limits go from floor-to-floor.  

3. For spaces on the top floor, use a limit offset of 1’ so that the space rises above the roof 

element. This will prevent false shading surfaces from showing up in the energy model  

Step 9 – Space and Zone Naming  

Naming spaces and zones can be the most tedious exercise involved with creating the 

analytical model. However, it is very important to have a name that will be allow you to identify 

the occupancy type once you have imported the GbXML file into the energy modeling software.  

At Interface Engineering, we are employing two tools to help with this. First is a tool available on 

Autodesk’s website called the Space Naming Utility. This tool takes the Room name found in 

the architectural model and automatically applies it to the space. In most cases, you are able to 

identify the occupancy type based on this name and is thus an acceptable method. The second 

tool we use was developed in-house called the Create Zones tool. This actually creates 1 zone 

for each space automatically while also giving the zone the same name as the space. The 

combination of these tools has saved us countless hours of work.   

Items to Note: 
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1. Use a naming convention that will allow you to determine the zone’s occupancy type 

once imported into the energy modeling software  

2. Add-in tools can expedite the zone creation and naming process  

3. eQUEST uses the Zone name from Revit 

4. Trace uses the Space name from Revit 

5. IES-VE uses the both the Zone name and a combination of the Space name and 

number 

Step 10 – Setting Space Load Parameters  

Revit allows you to specify load parameters in each space before it is exported to the energy 

modeling software. For example, lighting power density (LPD) and equipment load density 

(EPD) can be specified. While this information can be input in the specific energy modeling 

software you are using, it is often more convenient to do so in Revit. Its ability to schedule this 

information makes it very quick and easy to enter different LPDs and EPDs for different 

occupancy types.  

Select the spaces you want to edit and click Edit button next to the Electrical Loads parameter 

in the Properties dialog. Then, you can specify the lighting and equipment loads in either Watts 

or Watts/ft2. Unless you have actual lighting figures in the spaces (which will be discussed in a 

later section in detail), make sure to set the Values parameter to Specified.   

 



One Model to Rule them All: Using Revit to Create Multiple Analytical Energy Models 

19 
 

Another approach is to select all the spaces and change the Values parameter to Specified. 

Then use a space schedule to enter the desired load values. Once you add the load parameters 

to your space schedule they are editable.  

 

 

Step 11 –QCing the model 

There are several tools you can use to inspect the model to confirm it is set up properly. The 

space schedule is very useful for this purpose. Create a schedule with the fields shown in the 

picture below. The Space Height parameter is a calculated value which is simply the Volume 

divided by the Area.  



One Model to Rule them All: Using Revit to Create Multiple Analytical Energy Models 

20 
 

 

First, confirm that each space has a corresponding HVAC zone by searching the Zone column 

for any instances of Default. If a space is in the Default zone, that means you haven’t created an 

exportable HVAC zone for that space. Correct this by selecting the space and clicking the Zone 

button under the Analyze tab.  

 

Then, inspect the schedule to ensure each space is assigned to a level and the space is marked 

as occupiable. Check the space height column to ensure the spaces span from floor to floor. If 

you see a space that is different than the rest or shorter than the floor-to-floor height, select the 

zone and correct the issue.  

Another method of QCing the model is to look in the GbXML export dialog. Under the Details 

tab, you will notice un-zoned spaces will show up in the Default zone at the top of the list. 



One Model to Rule them All: Using Revit to Create Multiple Analytical Energy Models 

21 
 

 

This dialog will also display various errors, such as have a space that is not fully bounded: 
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Step 12 –Exporting the Model via GbXML 

Once you have inspected the model and corrected any errors, you are ready to export the 

GbXML file for use in the energy modeling software of your choice. Navigate to the Export to 

GbXML dialog  

Edit the Energy settings (Analyze>>Energy Analysis>>Energy Settings) 

 Set the Postal Code or city 

 Set the Ground Plane – This dictates which surfaces will be underground  vs above 

ground 

 Set the Project Phase – Spaces must be placed in the same phase as the Project 

Information phase 

 Energy Export Complexity set to Simple with Shading Surfaces – Keep in mind, the limit 

of shading surfaces in the model is 1024 

 Set Sliver Space Tolerance. Leave the default value of 1’ 0”. Too much sliver space may 

allow light, solar radiation, and air flow thermal transfer between zones that in reality do 

not occur 

 If you have specified LPD and/or EPDs, uncheck the export default values box 

 

Then, click Next and save the file in a location of your choice. 

That’s it! You now have a complete analytical model with load parameters ready for import into 

the energy modeling software. 
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Importing the Analytical Geometry into Simulation Software 

Importing to eQUEST via Green Building Studio  

Because eQUEST doesn’t have the ability to directly import a gbXML file, you must use 

Autodesk’s Green Building Studio. Navigate to https://gbs.autodesk.com/ and create an 

account. Create a new project, fill in the relevant information and upload the GbXML file you’ve 

created. The website will then process the file in the cloud. Once processing is complete, you 

can download a DOE2 input file which can be found on the Export and Download Data Files 

page.  

 

Next, open eQUEST and click “Select and Existing Project to Open”, change the file type to 

*.inp and navigate to the file you’ve just downloaded from GBS. Now you are ready to start 

modeling in eQUEST! 

https://gbs.autodesk.com/
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Items to Note: 

 eQUEST uses the HVAC Zone name from Revit for both the space and zone name. The 

spaces are preceded by S~zone- and zones are preceded by zone-. 

 Make sure to inspect the model in the 3-D Geometry tab for missing or incorrect (i.e. 

interior walls on an exterior surface or vice versa) surfaces. If you find errors, go back to 

Revit to troubleshoot the problem. It is most often caused by improperly aligned 

bounding surfaces. 
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 You’ll notice that the load parameters you defined in Revit will be present in 

the space elements 

 

Importing to EnergyPro 

For projects in California, Title 24 energy compliance is required to acquire a building permit. 

EnergyPro is very useful for quickly producing the necessary Title 24 calculations and forms.  It 

also has the ability to directly import the GbXML file without using Green Building Studio. That 

being said, it is a good idea to go through the eQUEST import process anyway because it 

provides a quick and easy way of inspecting the geometry with 3D representation of the model 

(which EnergyPro lacks). 

Open EnergyPro and navigate to File -> Import -> Green Building XML. Then just navigate to 

the file you saved in step 12 in the previous section. That’s it. Now you are ready to set up the 

remaining parts of your model in EnergyPro.  
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Items to Note: 

 EnergyPro references the Revit HVAC Zone name for its zone element, and the Revit 

space name for its space element. It will help to have a naming convention as described 

above, with both the space and the HVAC zone named very similarly in Revit.   

 EnergyPro doesn’t have a graphical representation of the model, so it is useful to use 

eQUEST to inspect the geometry before beginning modeling.  

 Load parameters are imported into EnergyPro along with the geometry.  

Importing to IES-VE 

IES Virtual Environment is a very powerful analysis tool and many modelers are shifting towards 

using it for performance models. The import process is very similar to EnergyPro. You simply 

navigate to File -> Import -> gbXML file. In the next dialog, click Import and point to the file 

saved during Step 12 in the previous section.  

During the import process, the program runs a special routine that “cleans up” any missing 

surfaces. This is a useful feature. Be aware that IES-VE does NOT import the load parameters 

from Revit.  

It is important is to note that IES imports the thickness of interior walls used in Revit, while other 

programs like eQUEST and EnergyPro do not. You need to remove the inner volumes in the 

thickness of the wall. The ModelIT module has a button that does this for you automatically.  

 

Items to Note: 

 IES-VE references the Revit space name for its Room elements 

 Load parameters do not import from Revit 

 Remove inner volumes from interior walls 

Import to Trane Trace 

The same analytical geometry created for energy analysis purposes can be imported to Trane 

Trace for load calculation purposes. This can save considerable time, as the analyst and the 
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designer can work from the same model. This also ensures consistent geometry and load 

assumptions. First, open Trace, create a new project then navigate to File-> Import gbXML and 

navigate to the file you saved in Step 12 of the previous section.  

You will then be presented with a dialog asking which features from the gbXML file you would 

like to import. If you’ve entered load information in Revit, check the boxes for the items you want 

to import. If you are planning to enter load information in Trace, do not check any of the items.  

 

Now you are ready to set up templates and proceed with your load calculation as you normally 

would.  

Items to Note 

 Trace Rooms reference the Space name in Revit  

 You can chose which load parameters you want to import from Revit. 

Import Load Calculations from Trace Back into Revit 

Once your load calculations are complete, you can import them back into Revit, which will then 

populate the calculated load parameters in the Space elements. This is useful for several 

reasons, including storing your load calculations, providing a visual quality control tool, and 

assisting with zonal system sizing.   

In Trace, navigate to File->Export->gbXML and point to the same file you used to import into 

Trace. This will modify the file to include calculated airflow, heating load, and cooling load. Next, 

import the file into Revit. Navigate to the Insert tab, click import gbXML, and navigate to the 

gbXML file.  

NOTE: This process relies on the naming scheme remaining unchanged. If you change the 

space or zone name in either Revit or Trace, the process will not work.  
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Now that you have the data in Revit, you can use it to assist with the design process.  

Using Loads Data from Trace in Revit 

One useful way to use the loads data calculated in Trace is for a visual representation of the 

load. Create dedicated views under the Mechanical discipline, and then apply a Color Scheme 

Template which applies a color to the spaces based on CFM/ft2.  For example, for a typical 

office or school building, a common rule of thumb is a building average cooling airflow of 1 

CFM/ft2. Use the Color Scheme tool to give a visual indication of the distribution of airflow.  

In the example shown below, I have set up three CFM/ft2 ranges: less than 1, between 1 and 2, 

and greater than 2. Each has its own associated color.   

 

 You would expect to see the highest airflows at perimeter zones (especially at the South and 

West) and low airflows at interior zones (especially corridors). The example below reveals this 

pattern.  
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Presenting the data in this way is very powerful for QCing the load calculation and 

understanding the distribution of air in the building. For example, if you noticed a red zone in the 

core of the building, it might indicate an error with the way the load calculation was set up. 

Perhaps an extra zero was accidentally added to the lighting power assumption.   

You can also create custom space tags to display relevant information to assist with selection of 

diffusers and VAV boxes. In the example below, the space tag displays the room area, supply 

air volume, CFM/ft2, and the peak heating and cooling loads. 

 

The approaches shown in this section are simply examples. There are numerous and creative 

ways a designer can use this data in Revit. Please be sure to share any novel ideas you have or 

are currently using in your design practice.   
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Importing a Revit Lighting Design into the Analytical Models 
One key input when creating an analytical energy model is the lighting power density (LPD). 

The LPD (W/ft2) is calculated by taking the total input power of the light fixtures in the space and 

dividing it by the floor area.  A typical workflow would be to manually count the different lighting 

fixture types and quantities in each space in order to calculate the LPD. When a complete 

lighting design is available in Revit MEP (i.e. unique fixture families for each fixture type are 

placed in the MEP model), the LPD can be automatically calculated for each Revit space by 

copying and pasting the fixtures from the MEP model to the analytical model. A number of 

settings and elements need to be in place in order for this to work.  

Revit’s Electrical Settings 

In order for Revit to calculate electrical loads in spaces, you must make some changes to the 

electrical settings. Open Revit’s electrical settings dialog box and select “Load Calculations” 

from the selectable options. Place a check in the “Run calculations for loads in spaces” box. 

When making your energy model template discussed in the first section, be sure this box is 

checked. 

 

Revit Lighting fixture families 

There are a few key components that need to be present on lighting fixture families in order to 

calculate LPD.  

Unique fixture type: Each fixture type on the luminaire schedule must have a corresponding 

fixture type in Revit. Each fixture type must have its input watts parameter set to the 

corresponding scheduled value.  

Electrical connectors: Every lighting fixture family must have an electrical connector.  The load 

classification of the connector must be set to a lighting load classification. The apparent load 

parameter on the connector must be mapped to an apparent load parameter. The apparent load 

units should be set to Watts.  
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Lighting Fixtures must touch the Revit space: In order for the electrical load of the fixture to be 

read by the space element, the lighting fixture must be located inside or touching the space.  

This is typically not a problem when the space extents are from floor to floor, but can become an 

issue when room bounded ceilings are in the model.  

Remember to: 

1. Verify the offset heights on the projects spaces. 

2. Verify the heights of the lighting fixtures – If the fixture sits outside of the space 

boundary, move it to the space (actual location of the fixture inside the room is irrelevant 

for energy analysis purposes). 

3. You can also use the Revit Room Calculation Point if a fixture doesn’t touch the space. 

Revit Space settings 

Revit Spaces hold all of the useful load parameters which is exported through the gbXML file 

and imported into energy analysis programs. By default, Revit will calculate the LPD by the 

space type settings. If you want Revit to calculate the LPD by the quantity of lighting fixtures 

placed in the space then you need to override the default lighting load settings to Actual. 

The electrical loads setting must be overridden manually for each space, but you can window 

select the entire building and filter out just the spaces to quickly make the needed adjustment. 
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Copy and Paste Lighting Fixtures from MEP Model to Analytical Model 

Now that we have the correct settings, copy and paste the lighting figures into the analytical 

model. In the MEP model, window select and copy all fixtures in each floor plan view using the 

filter tool. Then switch to the analytical model, navigate to the corresponding floor plan view, and 

use the Paste-Aligned to Current view to paste the fixtures. Note: This process needs to be 

done one floor at a time.  

Use Revit Lighting Schedule to QC the Model 

Once you have the fixtures imported, use schedules to verify that you have the same number of 

fixtures in both the MEP and analytical models. Create a Fixture Count Schedule in both models 

with the following fields and formatting features. This schedule can also be used to populate the 

Title 24 LTG forms  

 

Next, make a Lighting Fixture Schedule with the schedule properties shown below.  
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This will create a scheudle in the format shown below. This is useful for several reason. First, 

verify that the apparent load agrees with the luminaire schedule. Secondly, this allows you to 

verify that each fixture is placed in a space. If the Space:Name field is blank for any of the 

instances, this indicates a fixture is in the model, but not properly located in a space. Correct 

any issues before exporting the model.  

 

Use Color Schemes and Custom Space Tags to QC the Lighting Design 

Another useful way to QC both the model and the lighting design is to apply a color scheme with 

LPD ranges to a set of floor plan views. Similar to the way the load calculation data is QCed 

from Trace, the color scheme tool will provide a visual cue that there may be an issue with the 

lighting design or placement of fixtures.  

Create a color scheme similar to the one shown below. It uses four colors to indicate the 

performance of each space. Orange is displayed if the LPD is very low, green if it is in an 

optimum range, yellow if it is high but not unreasonable, and red if it is very high. The LPD 

ranges you chose will be different for each project.  
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This will create a floor plan view similar to this: 
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Another interesting tool to use is a custom space tag which tags each space with the LPD. 

 

Creating this space tag is very simple.  

1. Start of by creating a new family and using the Generic Tag.rfa family template.  

2. Next, select the Family Category and parameters button. 

3.  
4. Select Space Tags from the list of categories. Then close dialog box.  

5. From the Create Tab, select the Label button. Click into the working view to place the 

location of the label. The Edit label dialog box will open.  

6. The units of Lighting power density is W/sf. Select the parameter “Actual Lighting Load 

per area” from the available fields list. Double clicking or selecting the Green arrow will 

move the parameter over to the label parameters list.  

7. You can add text in the Prefix area if you would like to enhance the look of the tag.  

8.  

9. Locate the label at the intersection of the reference planes. The intersection of the 

reference planes will be the insertion point of the tag.  
10. Last, save the space tag family and load it into your project.  
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Using Revit to Create CFD Model Geometry and Boundary Conditions for 

Autodesk Simulation CFD  
Autodesk Simulation CFD is a powerful computational fluid dynamics simulation software that is 

capable of using Revit as its geometry creation user interface.  

General CFD Modeling Rules 

The following general rules apply when using the Revit plugin to export geometry to Simulation 

CFD using the: 

 Keep geometry as simple as possible. 

 Be careful to avoid offsets in geometry. Be sure to use the align tool for stacked and 

adjacent walls. 

 Always export the model from a 3D view. If you export from a floor plan or elevation, only 

the elements in the active view will export.  

 Only objects and features that are visible in the active 3D view will be exported. 

 Use visibility graphics and the hide elements commands to hide unnecessary objects to 

reduce geometric complexity and computational time. You can also use section boxes to 

exclude unnecessary elements.  

 Create independent boundary surfaces using independent building components. For 

example, if you want to analyze how a sun spot on a floor affects interior conditions, you 

need to create two independent floors in Revit (one that will be the warm boundary 

condition in the simulation and one that represents the remaining floor that is not in the 

sun spot).   

 A space fully enclosed by at least 6 surfaces will result in an interior volume element in 

the CFD program. If the space is not fully bounded, you will not get an interior volume.  

 To create an exterior volume around a building, create walls, roofs, and floors that 

surround the building with appropriate dimensions.  

External Flow Models 

External flow models are used to investigate how a given wind pattern interacts with a building. 

For example, you may wish to determine the wind pressure at a window for the purpose of 

investigating natural ventilation. In this case, we can use the same analytical model geometry 

we created for energy analysis.  

For an external flow simulation, you need to create an external volume around the building 

using walls, floors, and roofs according to the dimensions shown in the image below:  
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Here is an example of the analytical energy model geometry modified to include the walls, floor 

and roof that establish the extents of the external volume (the roof is hidden for demonstration 

purposes): 

 

And here is an image of the geometry once it’s been imported into Simulation CFD: 
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In order to simulate the average wind conditions, a velocity boundary condition is applied to the 

left-most surface of the external volume (the inlet). A zero pressure boundary condition is 

applied to the downwind surface to allow the “wind” to exit the solution field (the outlet). Notice 

that the building is situated off-axis from the external volume. This represents the average 

direction the wind blows throughout the year on this building’s site.  

Note, an air velocity boundary condition can only be simulated (accurately) as normal 

(perpendicular) to the one of the external volume surfaces. Slip/Symmetry boundary conditions 

are applied to all other surfaces of the external volume so that flow is not impeded by these 

surfaces. There is no need to delete any of the interior features that were created for the energy 

model geometry. Simply suppress those elements from the simulation once imported into 

Simulation CFD so they are not meshed into the flow field.  
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Here is an image showing the resulting static pressure on a window on the leeward side of the 

building: 

 

 

Internal Flow Models 

Internal flow models typically involve investigating air temperature and velocity distributions 

inside a specific space of the building. It is usually impractical to simulate the all the pressure 

relationships inside entire building so it’s best practice to investigate one room at a time. In this 

case, we can hide all the irrelevant portions of the energy model geometry in Revit using the 

Hide Elements command.  

Below is an example of an investigation of the performance of a naturally ventilated classroom. 

The natural ventilation system includes a set of three operable windows to allow outside air to 

enter the classroom, three perforated ceiling panels to allow air to transfer from the occupied 

space to the plenum, and three relief vents the relive air from the plenum into the adjacent 

corridor. The roof is hidden in the image below for demonstration. 
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The operable windows are modeled in Revit as simple window instances. It’s important to have 

independent windows for the non-operable windows below, so that boundary conditions can be 

applied only to the portion that is ventable. Similarly, four separate ceiling elements have been 

modeled in Revit in order to differentiate between the perforated portions and the impermeable 

portion. The relief vents are also modeled as simple window instances.  
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Here is an image of the model once it has been imported into Simulation CFD, again with the 

roof hidden for demonstration purposes. Volumetric flow rate and temperature boundary 

conditions have been imposed on the operable windows to simulate outside air entering the 

space. The three perforated ceiling panels have been assigned as resistance material with 18% 

free area to simulate the perforated panels. The relief vents have a zero pressure boundary 

condition to serve as the outlet.  
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Here are some snap shots of the results of the simulation showing the air velocity and 

temperature distributions.  
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